
 
COMPUTERIZED OFFICE MANAGEMENT 

BTS 
  MCQ QUESTIONS 

 
1. Ctrl + U 

A. Undelete the previously deleted text 
B. Undo the last changes 
C. Underline the document name 
D. Underline the selected text 

2.  Ctrl + V 
A. Paste Texts in the beginning of Document 
B. Paste Images in the beginning of Document         
C. Paste Tables at the middle of Document 
D. None of the above 

3.  Ctrl + W 
A. Save and Print the Document 
B. Save and Close Word Application 
C. Save and Close document 
D. Without Save, Close Document 

4.  Ctrl + X 
A. Close Document 
B. Close Word Application 
C. Cut the Selected Contents 
D. Copy the Selected Contents 

5.  Ctrl + Y 
A. Undo the last Action 
B. Repeat the last Action 
C. Delete the last page 
D. Delete the first page 

6.  Ctrl + Z 
A. Undo the last Action 
B. Redo the last Action 
C. Add the new page 
D. Paste the contents from clipboard 

7.  Page Up Key 
A. Moves the cursor one line up 
B. Moves the cursor one screen up 
C. Moves the cursor one page up 
D. Moves the cursor one paragraph up 

8. Page Down Key 
A. Moves the cursor one line down 
B. Moves the cursor one page down 
C. Moves the cursor one screen down 
D. Moves the cursor one paragraph down 

9.  Home Key 
A. Moves the cursor beginning of the document 
B. Moves the cursor beginning of the paragraph 



C. Moves the cursor beginning of the screen 
D. Moves the cursor beginning of the line 
10. End Key 
  A. Moves the cursor end of the line 
  B. Moves the cursor end of the document 
  C. Moves the cursor end of the paragraph 
  D. Moves the cursor end of the screen 

11.What is the shortcut key to split a table? 
  A. Ctrl + Alt + Enter 
  B. Ctrl + Shift + Enter 
  C. Alt + Shift + Enter 
  D. Alt + Space + Enter 

12. Page break is not a Section break 
A. True 
B. False  

13. Which of the following is not the Section Break Option? 
A. Next Page 
B. Previous Page 
C. Odd Page 
D. Even Page 

14. What is a Document Outline View? 
A. A preview in a full screen 
B. A preview with margins 
C. A View with a margins and gutter 
D. A view with a structure of heading at various levels 

15. What is the use of Document Map? 
A. to quickly format the document 
B. to quickly print required page 
C. to quickly navigate the document 
D. to quickly correct spelling mistakes 

16. What is the shortcut key to display field codes? 
A. Alt + F9 
B. Ctrl + F9 
C. Shift + F9 
D. Space + F9 

17. What is the shortcut key to show font dialog box? 
A. Ctrl + D 
B. Ctrl + Shift + F 
C. Ctrl + Shift + P 
D. All of the above 

 



 

18. How to remove all character formats? 
A. Shift + Spacebar 
B. Shift + Enter 
C. Ctrl + Spacebar 
D. Ctrl + Enter 

19. Which of the following is true regarding page Orientation of a Document? 
A. Page Orientation can be change at any time 
B. Page Orientation of document determines by printer 
C. Page Orientation must be set before start typing 
D. Page Orientation of a document cannot be changed. 

20. Which of the following is Page Orientation? 
A. Landscape 
B. Portrait 
C. Gutter 
D. Only A & B 

21. What is the use of bookmarks in Microsoft Word? 
A. To easily correct the spelling errors 
B. To quickly jump to a specific location in the document 
C. To quickly jump to the ending of the document 
D. To create a link within the document 

22. What is the shortcut-key for manual line break? 
A. CTRL + Enter 
B. Alt + Enter             
C. Shift + Enter 
D. Space + Enter 

23. Which feature helps you to inserts the contents of the Clipboard as text without any 
formatting 
A. Paste Special 
B. Format Painter 
C. Page Setup 
D. Styles 

24. Which feature is used to replace straight quotes with smart quotes as you type? 
A. Auto Correct as you type 
B. Auto Change as you type 
C. Auto Format as you type 
D. Smart Tags as you type 

25. Which of the following is correct regarding Underline in MS-Word? 
A. Color of Underline can be change 
B. Style of Underline can be change 
C. Underline can be set using by shortcut key 
D. All of the above  



26. How will MS Word will respond in repeated word. 
A. A Red wavy line under the repeated word 
B. A Green wavy line under the repeated word 
C. A Blue wavy line under the repeated word 
D. None of the above 

27. Tabs stop position cannot be the following alignment 
A. Decimal Alignment 
B. Center Alignment 
C. Bar Alignment 
D. Justify Alignment 

28. How to use Format Painter multiple times 
A. By Click on Lock Format Painter Icon 
B. By Double Click on the Format Painter Icon 
C. By Selecting Edit -> Format Painter -> Multiple Use 
D. Format Painter cannot be use multiple times 

29. Gutter position can be set in following positions 
A. Left & Right 
B. Left & Top 
C. Left & Bottom 
D. Left Only 

30. What is the use of “All Caps” feature in MS-Word? 
A. It changes all selected text into Capital Letter 
B. It adds captions for selected Image 
C. It shows all the image captions 
D. None of the above  

31.  A function inside another function is called _______ 
A. Nested function 
B. Round function 
C. Sum function 
D. Text function 

32.  Which of the following is not an underline option in the format cells dialog box? 
A. Double 
B. Single Accounting        
C. Double Accounting 
D. Single Engineering 

33.  Formulas in Excel start with 
A.   % 
B.   = 
C.   + 
D.   - 

 



34.  The default header for a worksheet is 
A. Username 
B. Date and Time 
C. Sheet tab Name 
D. None 

35.  Which of the following is not an option of the spelling dialog box? 
A. Ignore 
B. Ignore all 
C. Edit 
D. Change 

36.  Which of the following methods will not enter data in a cell? 
A. Pressing the Esc key 
B. Pressing an arrow key 
C. Pressing the tab key 
D. Clicking the enter button to the formula bar 

37.  The cell reference for cell range of G2 to M12 is _______ 
A.   G2.M12 
B.   G2;M12 
C.   G2:M12 
D.   G2-M12 

38.  What is the keyboard shortcut for creating a chart from the selected cell range? 
A.   F2 
B.   F4 
C.   F8 
D.   F11 

39. The Software which contains rows and columns is called ______ 
A. Database 
B. Drawing 
C. Spreadsheet 
D. Word processing 

40. You can group noncontiguous worksheets with 
A. The alt+enter key 
B. The ctrl key and mouse 
C. The shift key and the mouse 
D. The group button on the standard toolbar 

41. Comments put in cells are called ….. 
A. Smart Tip 
B. Cell Tip 
C. Web Tip 
D. Soft Tip 

 



42. Comments can be added to cells using ….. 
A. Edit -> Comments 
B. Insert -> Comment     
C. File -> Comments 
D. View –> Comments 

43. Which menu option can be used to split windows into two? 
A. Format -> Window 
B. View -> Window-> Split 
C. Window -> Split 
D. View –> Split 

44. Getting data from a cell located in a different sheet is called…. 
A. Accessing 
B. Referencing 
C. Updating 
D. Functioning 

45. Which of the following is not a valid data type in Excel? 
A. Number 
B. Character 
C. Label 
D. Date/Time 

46. Which elements of a worksheet can be protected from accidental modification? 
A. Contents 
B. Objects 
C. Scenarios 
D. All of the above 

47. A numeric value can be treated as label value if …… precedes it. 
A. Apostrophe (‘) 
B. Exclamation (!) 
C. Hash (#) 
D. Tilde (~) 

48. Concatenation of text can be done using 
A. Apostrophe (‘) 
B. Exclamation (!) 
C. Hash (#) 
D. Ampersand (&) 

49. Which area in an Excel window allows entering values and formulas? 
A. Title Bar 
B. Menu Bar 
C. Formula Bar 
D. Standard Tool Bar 

 



50. Multiple calculations can be made in a single formula using….. 
A. Standard Formulas 
B. Array Formula 
C. Complex Formulas 
D. Smart Formula 

 51. Single spacing in MS-WORD document causes ____ point line spacing? 
A. 10 
B. 12 
C. 14 
D. 16 

52. Which would you choose to display the statistics about a document? 
A. tools, word count 
B. insert, statistics 
C. tools, spelling and grammar 
D. tools, statistics 

53. Which feature do you use to create a newspaper like document? 
A. Bullets & numbering 
B. Tables 
C. Columns 
D. Tab stops 

54. Which would you choose to list Synonyms & Antonyms of a selected word? 
A. Tools, Spelling & Grammar 
B. Tools, Language 
C. Tools, Options 
D. Insert, Cross-reference 

55. Which language does MS-Word use to create Macros? 
A. Visual C++ 
B. Visual Basic 
C. FoxPro 
D. Access 

56. What do you call ‘a collection of character and paragraph formatting commands’? 
A. the defaults 
B. a template 
C. a style 
D. a boilerplate 

57. In MS Word, Ctrl+S is for ….. 
A. Scenarios 
B. Size 
C. Save 
D. Spelling Check 

 



58. Which key is used to increase left indent? 
A. Ctrl+I 
B. Ctrl+M 
C. Alt+I 
D. F10 

59. Which key is used to select all the text in the document? 
A. Ctrl+T 
B. Ctrl+A 
C. Ctrl+F 
D. Ctrl+N 

60. To undo the last work, press ….. 
A. Ctrl+U 
B. Ctrl+Y 
C. Ctrl+Z 
D. Ctrl+W 

61. Primary memory stores 
A. Data alone 
B. Programs alone 
C. Results alone 
D. All of these 

62. Memory unit is one part of 
A. Input device 
B. Control unit 
C. Output device 
D. Central Processing Unit 

63. Algorithm and Flow chart help us to 
A. Know the memory capacity 
B. Identify the base of a number system 
C. Direct the output to a printer 
D. Specify the problem completely and clearly 

64. Which of the following is not a valid size of a Floppy Disk? 
A. 8″ 
B. 5 1/4″ 
C. 3 1/2″ 
D. 5 1/2″ 

65. The basic operations performed by a computer are 
A. Arithmetic operation 
B. Logical operation 
C. Storage and relative 
D. All the above 

 



66. The earliest calculating devices are 
A. Abacus 
B. Clock 
C. Difference Engine 
D. None of these 

67. Who built the first Mechanical Calculator 
A. Joseph Marie Jacquard 
B. John Mauchly 
C. Blaise Pascal 
D. Howard Aiken 

68. Which Chart can be created in Excel? 
A. Area 
B. Line 
C. Pie 
D. All of the above 

69. How do you display current date and time in MS Excel? 
A. date () 
B. Today () 
C. now () 
D. time () 

70. How do you display current date only in MS Excel? 
A. date () 
B. Today () 
C. now () 
D. time () 

71. How do you wrap the text in a cell? 
A. Format, cells, font 
B. Format, cells, protection 
C. format, cells, number 
D. Format, cells, alignment 

72. What does COUNTA () function do? 
A. counts cells having alphabets 
B. counts empty cells 
C. counts cells having number 
D. counts non-empty cells 

73. What is the short cut key to highlight the entire column? 
A. Ctrl+C 
B. Ctrl+Enter 
C. Ctrl+Page Up 
D. Ctrl+Space Bar 

 



74. In the formula, which symbol specifies the fixed columns or rows? 
A. $ 
B. * 
C. % 
D. & 

75. Excel displays the current cell address in the ………. 
A. Formula bar 
B. Status Bar 
C. Name Box 
D. Title Bar 

76. What is the correct way to refer the cell A10 on sheet3 from sheet1? 
A. sheet3!A10 
B. sheet1!A10 
C. Sheet3.A10 
D. A10 

77. When sharing data in Office, the ________ document is the document in which the data was 
first entered. 
A. source 
B. destination 
C. original 
D. primary 

78. Which command is used to establish a link between a source document and a destination 
document? 
A. Tools, Link, Documents 
B. Tools, Link  
C. Edit, Link 
D. Edit, Paste Special 

79. Which option enables automatic updates in destination documents? 
A. embedding 
B. objects 
C. links 
D. relationships 

80. Which is an Office feature that makes it easy to edit embedded objects?  
A. pasting 
B. visual editing 
C. tools, update, links 
D. edit, links 

81. Which is true when you insert an excel worksheet into a word document? 
A. word is the destination document 
B. excel is the destination document 
C. the worksheet is the destination document 
D. the document is the source document 



82. What would you do when you want to update the data in an embedded worksheet range? 
A. double click the worksheet range object 
B. right click worksheet range object & choose format object 
C. edit the data in the destination document 
D. edit the data in the source document. 

83. Which can be used for quick access to commonly used commands and tools? 
A. Status bar 
B. Tool bar 
C. Menu bar 
D. Title bar 

84. With which view can you see how text and graphics will appear on the printed page? 
A. Normal 
B. Print Layout 
C. Outline 
D. Web Layout 

85. Which simplifies the process of formatting text if the same formatting is required in more 
than one location? 
A. Auto Text 
B. Format Painter 
C. Font dialog box 
D. None of the above 

86. Which of the following is best for quick copy operation? 
A. Copy and Paste 
B. Windows Clipboard 
C. Drag and Drop 
D. Auto Text 

87. Which option in File pull-down menu is used to close a file in MSWord? 
A. New 
B. Quit 
C. Close 
D. Exit 

88. Which bar is usually located below that Title Bar that provides categorized options? 
A. Menu bar 
B. Status Bar 
C. Tool bar 
D. Scroll bar 

89. Which of these toolbars allows changing of Fonts and their sizes? 
A. Standard 
B. Formatting 
C. Print Preview 
D. None of these 



90. Which key should be pressed to start a new paragraph in MS-Word? 
A. Down Cursor Key 
B. Enter Key 
C. Shift + Enter 
D. Ctrl + Enter 

91. Which menu in MSWord can be used to change character size and typeface? 
A. View 
B. Tools 
C. Format 
D. Data 

92. By default, on which page the header or the footer is printed? 
A. on first page 
B. on alternate page 
C. on every page 
D. none of the above 

93. In MS-Word, for what does ruler help? 
A. to set tabs 
B. to set indents 
C. to change page margins 
D. All of the above 

94. Using Find command in Word, we can search? 
A. characters 
B. formats 
C. symbols 
D. All of the above 

95. MS-Word automatically moves the text to the next line when it reaches the right edge of the 
screen and is called? 
A. Carriage Return 
B. Enter 
C. Word Wrap 
D. None of the above 

96. Selecting text means, selecting? 
A. a word 
B. an entire sentence 
C. whole document 
D. any of the above 

 97. What is the shortcut key to “Center Align” the selected text? 
A. Ctrl + C 
B. Ctrl + E 
C. Ctrl + F 
D. None of above 



98. What is the shortcut key to “Undo” the last action in a document? 
A. Ctrl + X 
B. Ctrl + Y      
C. Ctrl + Z 
D. None of above 

99. What is the shortcut key to “Insert Hyperlink” in a document? 
A. Ctrl + H 
B. Ctrl + L 
C. Ctrl + K 
D. None of above 

100. What is the shortcut key for “Find and Replace” dialog box? 
A. Ctrl + F 
B. Ctrl + R 
C. Ctrl + H 
D. Ctrl + Shift + F 

101. What is the shortcut key for Spelling Check in document? 
A. F7 
B. Shift + F7 
C. Ctrl + F7 
D. Alt + F7 

102. What is the shortcut key to Update Formula in a table? 
A. F9 
B. Alt + F9 
C. Ctrl + F9 
D. Shift + F9 

103. What is the shortcut key to Close Active Document in Microsoft Word? 
A. Ctrl + F4 
B. Shift + F4 
C. Ctrl + Shift + F4 
D. None of above 

104. What is the shortcut key for “Font” dialog box? 
A. Ctrl + F 
B. Ctrl + D 
C. Ctrl + G 
D. None of the above 

105. What is the shortcut key for “Superscript” the selected text? 
A. Ctrl + = 
B. Ctrl + - 
C. Ctrl + Shift + = 
D. Ctrl + Shift + - 

 



106. What is the shortcut key for “Subscript” the selected text? 
A. Ctrl + = 
B. Ctrl + - 
C. Ctrl + Shift + = 
D. Ctrl + Shift + - 

107. Single spacing in MS-WORD document causes ____ point line spacing? 
A. 10 
B. 12 
C. 14 
D. 16 

108. Which would you choose to display the statistics about a document? 
A. tools, word count 
B. insert, statistics 
C. tools, spelling and grammar 
D. tools, statistics 

109. Which feature do you use to create a newspaper like document? 
A. Bullets & numbering 
B. Tables 
C. Columns 
D. Tab stops 

110. Which would you choose to list Synonyms & Antonyms of a selected word? 
A. Tools, Spelling & Grammar 
B. Tools, Language 
C. Tools, Options 
D. Insert, Cross-reference 

111. Which language does MS-Word use to create Macros? 
A. Visual C++ 
B. Visual Basic 
C. FoxPro 
D. Access 

112. What do you call ‘a collection of character and paragraph formatting commands’? 
A. the defaults 
B. a template 
C. a style 
D. a boilerplate 

113. In MS Word, Ctrl+S is for ….. 
A. Scenarios 
B. Size 
C. Save 
D. Spelling Check 

 



114. Which key is used to increase left indent? 
A. Ctrl+I 
B. Ctrl+M 
C. Alt+I 
D. F10 

115. Which key is used to select all the text in the document? 
A. Ctrl+T 
B. Ctrl+A 
C. Ctrl+F 
D. Ctrl+N 

116. To undo the last work, press ….. 
A. Ctrl+U 
B. Ctrl+Y 
C. Ctrl+Z 
D. Ctrl+W 

117. In Computer System Scanner is ______ Device? 
A. Input 
B. Output         
C. Both 
D. None 

118. Speed of Laser Printer is measured in 
A. LPM 
B. PPM 
C. DPI 
D. DPS 

119. Which of the following is not Computer Hardware? 
A. Mouse 
B. Monitor 
C. Antivirus 
D. Printer 

120. What is the main purpose of the secondary storage device? 
A. To increase the speed of Computer 
B. To Install Operating System 
C. To Networking 
D. To Store Data 

121. A Dumb terminal has 
A. Processor and Keyboard 
B. Processor and Hard Disk 
C. Keyboard and Hard Disk 
D. Keyboard and Screen 

 



122. Who invented Integrated Circuit (IC)? 
A. Herman Hollerith 
B. Jack Kilby 
C. Semen Korsakov 
D. Bill Gates 

123.  The output quality of a printer is measured by 
A.  Dot per sq. inch 
B.  Dot per inch 
C.  Dots printed per unit time 
D.  All of the above 

124.  Main storage is also called 
A.  Accumulator 
B.  Control Unit 
C.  Register Unit 
D.  Memory 

125.  After copying the content how many times can you paste? 
A.  1 
B.  16 
C.  32 
D.  Many 

126. Which file format can be added to a PowerPoint show? 
a. .jpg 
b. .giv 
c. .wav 
d. All of the above 
 
127. In Microsoft PowerPoint two kind of sound effects files that can be added to the 
presentation are 
a. .wav files and .mid files 
b. .wav files and .gif files 
c. .wav files and .jpg files 
d. .jpg files and .gif files 
 
128. Material consisting of text and numbers is best presented as 
a. A table slide 
b. A bullet slide 
c. A title slide 
d. All of the above 
 
129. What is a motion path? 
a. A type of animation entrance effect 
b. A method of advancing slides 
c. A method of moving items on a slide 
d. All of the above 
 
 



130. What is a slide-title master pair? 
a. The title area and text area of a specific slide 
b. a slide master and title master merged into a single slide 
c. A slide master and title master for a specific design template 
d. All of above 
 
131. Which of the following should you use if you want all the slide in the presentation to 
have the same “look”? 
a. the slide layout option 
b. add a slide option 
c. outline view 
d. a presentation design template 
 
132. in the context of animations, what is a trigger? 
a. An action button that advances to the next slide 
b. An item on the slide that performs an action when clicked 
c. The name of a motion path 
d. All of above 
 
133. If you have a PowerPoint show you created and want to send using email to another 
teacher you can add the show to your email message as a (an) 
a. Inclusion 
b. Attachment 
c. Reply 
d. Forward 
 
134. In order to edit a chart, you can 
a. Triple click the chart object 
b. Click and drag the chart object 
c. Double click the chart object 
d. Click the chart object 
 
135. to exit the PowerPoint 
a. click the application minimize button 
b. click the document close button 
c. double click the applications control menu icon 
d. double click the document control menu icon 
 
136. to preview a motion path effect using the custom animation task pane, you should 
a. click the play button 
b. click the show effect button 
c. double click the motion path 
d. all of above 
 
137. You can create a new presentation by completing all of the following except 
a. Clicking the new button on the standard toolbar 
b. Clicking file, new 
c. Clicking file open 
d. Pressing ctrl + N 
 



138. You can embed a MS-Organization Chart in a slide by 
a. Clicking the object command on the edit menu 
b. Clicking the object command on the edit menu 
c. Clicking the insert new slide button the standard toolbar, then double click the organization 
chart button on the formatting toolbar 
d. Clicking the MS-Organization Chart button on the standard toolbar 
 
139. To select one hyperlink after another during a slide presentation, what do you press? 
a. Tab 
b. Ctrl + K 
c. Ctrl + h 
d. All of above 
 
140. special effects used to introduce slides in a presentation are called 
a. effects 
b. custom animations 
c. transitions 
d. present animations 
 
141. How was the generation of computer classified? 
A. by the device used in memory & processor 
B. by the speed of computer 
C. by the model of the computer 
D. by the accuracy of computer 
 
142. What is the term used when you press and hold the left mouse key and more the 
mouse around the slide? 
a. Highlighting 
b. Dragging 
c. Selecting 
d. Moving 
 
143. Which of the following toolbars provide different options in various master views? 
a. Common tasks toolbar 
b. Drawing toolbar 
c. Formatting toolbar 
d. Standard toolbar 
 
144. The Second Generation Computer was based on …………. 
A. Vacuum Tube                           
 B. Silicon Chips 
C. Transistor 
 D. Bio Chips 
 
145. The Third Generation Computer was made with …………. 
A. Vacuum Tube                         
 B. Discrete Components 
C. IC                                              
 D. Bio Chips 
 



146. Which option on the custom animation task pane allows you to apply a preset or 
       custom motion path? 
a. Add effect 
b. Emphasis 
c. Animate now 
d. All of the above 
 
147. What is the term used when a clip art image changes the direction of faces? 
a. Group 
b. Flip 
c. Rotate 
d. All of the above 
 
148. the slide that is used to introduce a topic and set the tone for the presentation is called 
the 
a. table slide 
b. graph slide 
c. bullet slide 
d. title slide 
 
149. Which of the following features should you use when typing in the notes text box? 
a. Slide show 
b. Insert 
c. Slide maser 
d. Zoom 
 
150. Which option allows you to select line, curve, freeform or scribble tools? 
a. Create effect 
b. Insert motion path 
c. Draw custom path 
d. All of the above 
 
151. Which of the following should be used when you want to add a slide to an existing 
presentation? 
a. File, add a new slide 
b. Insert, New slide 
c. File Open 
d. File, New 
 
152. The size of the organization chart object 
a. Is determined by the presentation design and can not be changed 
b. Is determined by the presentation design but can be changed in PowerPoint 
c. Is dependent on the amount of text within the organization chart 
d. b and c 
 
153. which of the following is the default page setup orientation of slide in PowerPoint 
a. rVertical 
b. Landscape 
c. Portrait 
d. None of above 



 
154. Want a PowerPoint photo album slide show to play continuously? 
a. Use random slide transitions 
b. Launch an online broadcast 
c. Loop continuously 
d. All of the above 
 
155. When did John Napier develop logarithm? 
A. 1416                                          
B. 1614 
C. 1641                                           
D. 1804 
 
156. Which of the following tool enables you to add text to a slide without using the 
standard placeholders? 
a. Text tool box 
b. Line tool 
c. Drawing tool 
d. Auto shapes tool 
 
157. Punched cards were first introduced by 
A. Powers                                       
B. Pascal 
C. Jacquard                                    
D. Herman Hollerith 
 
158. Want your logo in the same position on every slide, automatically? Insert it on the 
a. Handout master 
b. Notes master 
c. Slide master 
d. All of the above 
 
159. Which of the following views is the best view to use when setting transition effects for 
all slides in a presentation? 
a. Slide sorter view 
b. Notes pages view 
c. Slide view 
d. Outline view 
 
160. Objects on the slide that hold text are called 
a. Placeholders 
b. Object holders 
c. Auto layouts 
d. Text holders 
 
161. Which of the following provides a means of printing out feature notes with a 
miniature slide on a printed page? 
a. Slide with animation 
b. Outline view 
c. Notes page 



d. Audience handout 
 
162. Which command brings you to the first slide in your presentation? 
a. Next slide button 
b. Page up 
c. Ctrl + Home 
d. Ctrl + End 
 
163. In normal view, how can you quickly change to handout master view? 
a. Click the outline tab and select handout master view 
b. Press the shift key and click the handout master view button 
c. On the view menu, click slide sorter, and click handouts. 
d. All of above 
 
164. What was the first general-purpose electronic computer? 

a. IBM 405  
b. Zuse Z3  
c. ENIAC  
d. CSIRAC 

 
165. Which of the following can you use to add times to the slides in a presentation? 
a. Slide show menu 
b. Rehearse timings button 
c. Slide transition button 
d. All of the above 
 
166. To select all of the boxes of an organization chart 
a. Clicking and edit and select all 
b. Right click the chart background and then click select all 
c. Press and hgold the SHIFT key and click each box 
d. All of above 
 
167. You can show the shortcut menu during the slide show by 
a. Clicking the shortcut button on the formatting toolbar 
b. Right clicking the current slide 
c. Clicking an icon on the current slide 
d. a and b 
 
168. Auto clipart is a feature that 
a. Automatically places clipart in your presentation 
b. Scans your presentation for incorrect spelling in your words on each slide 
c. Scans your presentation for incorrect spelling in Word Arts objects 
d. All of above 
169. The Analytical Engine developed during First Generation of computers used ___ as a 
memory unit 
A. RAM                                        
B. Floppies 
C. Cards                                        
D. Counter Wheels 



 
170. Whidh of the following allow you to select more than one slide in a presentation? 
a. Alt + Click each slide 
b. Shift + drag each slide 
c. Shift + Click each slide 
d. Ctrl + Click each slide 
 
171. The view that displays the slides on a presentation as miniature representations of the 
slides is called 
a. slide show 
b. slide sorter view 
c. notes page view 
d. outline view 
 
172. The PowerPoint view that displays only text (title and bullets) is 
a. Slide show 
b. Slide sorter view 
c. Notes page view 
d. Outline view 
 
173. In Microsoft PowerPoint the entry effect as one slide replaces another in a show is 
called a (an) 
a. animation 
b. slide transition 
c. custom animation 
d. preset animation 
 
174. Which of the following presentation elements can you modify using the slide master? 
a. Slide comments 
b. Slide transitions 
c. Speaker note font and color 
d. All of above 
 
175. Which of the following provides a printed copy of your presentation? 
a. Outline 
b. Speaker notes 
c. Audience handouts 
d. All of the above 
 
176. Slide show options available to the presenter include all of the following except 
a. Transitions command 
b. Speaker notes command 
c. Meeting reminder command 
d. Navigation commands 
 
177. Presentation designs regulate the formatting and layout for the slide and are 
commonly called 
a. Design plates 
b. Templates 
c. Placeholders 



d. Blueprints 
178. Which of the following bypasses the print dialog box when printing individual slides 
or an entire presentation? 
a. File, print, preview 
b. The print button 
c. File, print 
d. Ctrl + p 
 
179. To add a header or footer to your handout, you can use 
a. The title master 
b. The slide master 
c. The handout master 
d. All of above 
 
180. Which of the following will not advance the slides in a slide show view? 
a. Esc key 
b. The spacebar 
c. The Enter key 
d. The mouse button 
 
181. The programs which are as permanent as hardware and stored in ROM is known as 
A. Hardware                                  
 B. Software 
C. Firmware                                   
 D. ROM ware 
 
182. Comments on a presentation can record who wrote them and when they were added. 
What’s the automatic way in PowerPoint 2002? 
a. Use online collaboration 
b. Use comments 
c. Use the notes page 
d. All of the above 
 
183. When using PowerPoint, to play a PowerPoint show for previewing the show, select 
a. View, slide sorter 
b. View, slide 
c. View, slide show 
d. View outline 
 
184. In Microsoft PowerPoint in order to see all the slides on one screen use 
a. view, slide sorter 
b. view, slide 
c. view, master 
d. view, slide show 
 
185. What’s the best place to find animated images for your PowerPoint 2002 
presentation? 
a. Microsoft online 
b. Word clipart 
c. PowerPoint tools and ins 



d. All of the above 
Correct Answer: b 
 
186. What’s the easy way to apply varied animations to test on slides 
a. apply effects in the custom animation text pane 
b. apply an animation scheme 
c. customize bullets with animated clipart 
d. all of above 
 
187. Which of the following is a read only memory storage device? 
A. Floppy Disk                              
 B. CDROM 
C. Hard Disk                                   
D. None of these 
 
188. Which of the following is a programming language? 
A. Lotus                                          
B. Pascal 
C. MS-Excel                                  
 D. Netscape 
 
189. You can create a new presentation by completing all of the following except: 
a. Clicking the new button on the standard toolbar 
b. Clicking file, new 
c. Clicking file open 
d. Pressing Ctrl + N 
 
190. Which of the following is not an output device? 
A. Scanner                                      
B. Printer 
C. Flat Screen                                
D. Touch Screen 
 
191. Which of the following options in the printer dialog box would you select to prit slides 
5 and 12 in a presentation? 
 
a. Slides 
b. Custom shows 
c. Current slide 
d. All 
 
192. Which of the following toolbars provides different options in various master views? 
a. Common tasks toolbar 
b. Drawing toolbar 
c. Formatting toolbar 
d. Standard toolbar 
 
193. You can tell when an object is active because 
a. The object is highlighted 
b. Eight small sizing handles appear surrounding the text 



c. A box frame appears surrounding the text 
d. b and c 
 
194. Which of the following is not an option when printing handouts? 
a. Six slides per page 
b. Five slides per page 
c. Three slides per page 
d. Two slides per page 
 
195. _______ is used for scanning the pictures and putting them in digitized form in the 
computer. 
A. CD-ROM                                   
B. Plotter 
C. Bar-coder                                   
D. Scanner 
 
196. Any and every command can be found on the 
a. Drawing toolbar 
b. Formatting toolbar 
c. Standard toolbar 
d. Menu bar 
 
197. The slide that is used to introduce a topic and set the tone for the presentation is called 
the 
a. Table slide 
b. Graph slide 
c. Bullet slide 
d. Title slide 
 
198. Which is a volatile memory? 
A. ROM                                          
B. BIOS 
C. PROM                                        
D. RAM 
 
199. Which of the following features should you use when typing in he notes text box? 
a. Slide shows 
b. Insert 
c. Slide master 
d. Zoom 
 
200. Which of the following should e used when you want to add a slide to an existing 
presentation? 
a. File, add a new slide 
b. Insert, new slide 
c. File, open 
d. File, new 


